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NOTICE 

1. Read this manual before installing or operating. Keep this instruction manual on hand 
of the end user, and make use of this manual in maintenance and inspection.  

2. All information contained in this manual will be changed without notice. Please 
contact your Toshiba distributor to confirm the latest information. 
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Introduction 
Thank you for purchasing the “EtherCAT® option (IPE003Z)” for TOSVERT VF-MB1/S15 
drive. Before using EtherCAT® module, carefully read this function manual in order to 
completely and correctly utilize its excellent performance. 
This option needs the option adaptor to connect VF-S15 which type form is SBP009Z. 
Please match here and buy it when SBP009Z is not at hand yet. 
 
After reading this function manual, please keep it handy for future reference. 
For details of its general handling, see an instruction manual attached with the option 
unit. 
 
- TOSVERT VF-MB1 Instruction Manual ························································· E6581697 
- TOSVERT VF-S15 Instruction Manual ·························································· E6581611 
- TOSVERT VF-MB1/S15 communication option Precautions Manual ··········· E6581739 
- TOSVERT VF-MB1 Communication Function Instruction Manual ················ E6581726 
- TOSVERT VF-S15 Communication Function Instruction Manual ················· E6581913 
- VF-S15 Option Adapter Instruction Manual··················································· E6581838 
 

 
EtherCAT® is a registered trademark and patented technology, licensed by Beckhoff 
Automation GmbH, Germany. 
 
Profile 
The VF-MB1/S15 supports CiA®402 V3 drive profile, using CoE(CANOpen Over 
EtherCAT) 
 
BECKHOFF® software 
The VF-MB1/S15 communication card supports BECKHOFF software TwinCAT® V2.x 
with CodeSys V2. 
 
Further reading 
Recommended literature for further reading 
EtherCAT Technology Group (ETG), see “www.ethercat.org” 
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Handling in general  
 

 Warning 

 
Prohibited 

 Do not connect or disconnect a network cable while the drive power is on. 
It may lead to electric shocks or fire. 

 
Mandatory 

 See the instruction manual attached with the option unit for cautions the handling. 
Otherwise, it may lead to electric shocks, fire, injuries or damage to product. 

Network control 
 

 Warning 

 
Prohibited 

 Do not send the value out of the valid range to objects and attributes. 
Otherwise, the motor may suddenly start/stop and that may result in injuries. 

 
Mandatory 

 Use an additional safety device with your system to prevent a serious accident due to the
network malfunctions. Usage without an additional safety device may cause an accident.

 

 Caution 

 
Mandatory 

 Set up “Communication error trip function (see below)” to stop the drive when the option 
unit is deactivated by an unusual event such as tripping, an operating error, power 
outage, failure, etc. 

- Network Time-Out, drive operation at disconnection, Preset speed operation 
selection 
(Refer to "3.3.1 Network error detection (c100 - c103)" for details) 

Deactivated the option module may cause an accident, if the “Communication error trip 
function” is not properly set up. 
 Make sure that the operation signals are STOP before resetting drive’s fault. The motor 
may suddenly start and that may result in injuries. 

Notes on operation
 

Notes 
  When the control power is shut off by the instantaneous power failure, communication 

will be unavailable for a while. 
 The Life of EEPROM is approximately 100,000 times. Avoid writing a command more 
than 100,000 times to the same parameter of the drive and the option module.  

 

 



 E6581818 

- 3 - 

Table of Contents 
 
1. OVERVIEW .................................................................................................................................................5 

1.1. Communication and Services ..............................................................................................................5 
 
2. NAMES AND FUNCTIONS ........................................................................................................................6 

2.1. Outline ..................................................................................................................................................6 
2.2. RJ45 connector pin layout ...................................................................................................................7 
2.3. LED indicator........................................................................................................................................8 

 
3. PARAMETERS ...........................................................................................................................................9 

3.1. Communication parameters.................................................................................................................9 
3.2. Communication parameters for IPE003Z ............................................................................................9 
3.3. The details of the parameter setting ..................................................................................................12 

3.3.1. Network error detection (c100 - c103) ..............................................................................12 
 
4. COMMUNICATION OBJECT ...................................................................................................................13 

4.1. Communication Profile .......................................................................................................................13 
4.2. RPDO: Receive PDO.........................................................................................................................14 
4.3. TPDO: Transmit PDO ........................................................................................................................14 
4.4. MB1/S15 specific profile.....................................................................................................................14 
4.5. Application Profile (CiA402) ...............................................................................................................15 
4.6. Abort code (CiA 301)..........................................................................................................................16 

 
5. DRIVE PROFILE.......................................................................................................................................17 

5.1. CiA 402 Drive profile ..........................................................................................................................17 
5.2. TOSHIBA Drive profile .......................................................................................................................17 

 
6. CIA®402 – IEC61800-7 FUNCTIONAL PROFILE....................................................................................24 

6.1. Velocity mode object ..........................................................................................................................24 
6.1.1. CiA 402 profile ............................................................................................................................24 
6.1.2. TOSHIBA drive profile.................................................................................................................25 
6.1.3. Object 0x6040: Controlword .......................................................................................................26 
6.1.4. Object 6041: Statusword ............................................................................................................26 
6.1.5. CiA402 State Chart .....................................................................................................................28 
6.1.6. Object 0x6042: vl_target_velocity...............................................................................................30 
6.1.7. Object 0x6043: vl_velocity_demand...........................................................................................30 
6.1.8. Object 0x6044: vl_velocity_actual_value....................................................................................30 
6.1.9. Object 0x6046: vl_velocity_min_max_amount ...........................................................................30 
6.1.10. Object 0x6048: vl_velocity_acceleration.................................................................................31 
6.1.11. Object 0x6049: vl_velocity_deceleration.................................................................................31 
6.1.12. Object 0x604A: vl_velocity_quick_stop...................................................................................31 
6.1.13. Object 0x605A: Quick stop option code..................................................................................31 
6.1.14. Object 0x6060: Mode of operation..........................................................................................32 
6.1.15. Object 0x6061: Mode of operation display..............................................................................32 
6.1.16. Object 0x6502: Supported drive mode ...................................................................................32 

6.2. Object 603F: Error Code....................................................................................................................33 
 
7. ETHERCAT STATE MACHINE (ESM).....................................................................................................34 
 
8. EXAMPLE: VF-MB1 WITH TWINCAT® “PLC - CONFIGURATION”......................................................36 

8.1. Hardware............................................................................................................................................36 
8.2. TwinCAT® software installation..........................................................................................................36 
8.3. ESI file (EtherCAT Slave Information) ...............................................................................................36 
8.4. MB1 configuration ..............................................................................................................................36 
8.5. System Manager: Declare your computer on Ethernet network........................................................37 
8.6. System Manager: Install the master ..................................................................................................38 
8.7. System Manager – Install the slave: MB1 in “PLC- configuration” ....................................................40 
8.8. PLC – Control: initialization................................................................................................................41 



 E6581818 

- 4 - 

8.9. PLC – Control: Declare the variables.................................................................................................42 
8.10. System Manager – Append PLC Project........................................................................................43 
8.11. PLC - Control: new compilation......................................................................................................45 
8.12. System Manager: Activate configuration........................................................................................45 
8.13. PLC - Control: new compilation......................................................................................................45 
8.14. PLC - Control: start and stop the motor..........................................................................................45 
8.15. PLC - Control: add a library for other services ...............................................................................46 
8.16. Method of add the PDOs................................................................................................................47 

 

 



 E6581818 

- 5 - 

1. Overview 
The EtherCAT® interface (IPE003Z) allows the VF-MB1/S15 drive to be connected into the EtherCAT® 

network. 

 

 
 

1.1. Communication and Services 

Cyclical Communication: PDO 

• PDO is intended for use with the communication scanner according to CiA402. 

• PDO provides scan cycle optimization which allows short reaction time application (< 5 ms). 

• PDO overview (default settings) 

RPDO (CMD) (LFRD) (None) (None) (None) (None) 
       

TPDO (ETA) (RFRD) (None) (None) (None) (None) 

 

CMD: Controlword 

LFRD: Vl_Target_Velocity 

ETA: Statusword 

RFRD: Vl_Velocity_Actual value 

 

The configuration means are: 

• EtherCAT configuration tool, then the configuration is downloaded by the master, 

 

Acyclic Services: SDO 

The VF-MB1/S15 manages a SDO server (Service Data Object). SDO telegrams are used for 

configuration and adjustment, they are characterized by two identifiers: 

• One for requests (telegrams sent from the PLC to the VF-MB1/S15) 

• One for responses (telegrams sent back to the PLC by the VF-MB1/S15) 

 

Other Supported Services 

Assignment by default of address-based identifiers. 

• EtherCAT state machine commands 

• Emergency (EMCY) 

 

ESI file (EtherCAT Slave Information) 

Download the ESI file in XML format for VF-MB1 and VF-S15 on www.inverter.co.jp. 
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2. Names and functions 
The drawing below shows names and functions of main parts. 

 

2.1. Outline 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shielded female RJ45 

Ethernet Connector 

  (Port IN) 

LED indicator (See 2.3) 

Shielded female RJ45 

Ethernet Connector 

(Port OUT)

 

Connector to the inverter 

Release tab 

 

ERR 

 

X2 L/A 

RUN

L/A X1

X1 means EtherCAT IN port,  

X2 means EtherCAT OUT port 
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2.2. RJ45 connector pin layout 

The EtherCAT® unit is equipped with two shielded RJ45 connectors. When you use  

VF-MB1, the shielding is connected to the drive ground. When you use VF-S15, the  

shielding is connected to the grounding terminal of option adapter. 

Use an STP (shielded twisted pair) Ethernet cable. 

The transmission speed is detected automatically by the card (10 Mbps or 100 Mbps). 

The card can operate in half duplex or full duplex mode, whether connected to a hub or a 

switch and regardless of the transmission speed (10 Mbps or 100 Mbps). 

 

Pin Signal Meaning 

1 TX+ Ethernet transmit line +

2 TX- Ethernet transmit line - 

3 RX+ Ethernet receive line + 

4 -  

5 -  

6 RX- Ethernet receive line - 

7 -  

8 -  

 

* Fix a cable so that a communication connector may be not taken the weight of wire. 

 

Cable specifications 

• Minimum Cat 5e, 

• Use equipotential bonding conductors, 

• Connector RJ45, no crossover cable 

• Shield: both ends grounded 

• Twisted pair cable 

• Cable: 8 x 0.25 mm2 (8 x AWG 22) 

• Use pre-assembled cables to reduce the wiring mistakes, 

• Verify that wiring, cables and connected interfaces meet the PELV requirements. 

• Maximum cable length = 100 m (328 ft) 

 

Port IN (L/A X1 EtherCAT)  
and Port OUT (X2 L/A EtherCAT) 

8 1 
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2.3. LED indicator 

The LEDs shows the present  

status of the network and module. 
 
 
 

 
The behavior of X1 L/A LED and L/A X2 LED 

These LEDs indicate the status of the EtherCAT IN port (X1 L/A) and OUT port (L/A 
X2) 

Color and behavior Meaning 

OFF No link 
Green ON Link, no activity 
Green Flickering Link, activity 

 
The behavior of RUN LED 

It LED indicate the RUN status or RUN error 

Color and behavior Meaning 

OFF EtherCAT state: INIT 
Green blinking EtherCAT state: PRE-OPERATIONAL 
Green single flashing EtherCAT state: SAFE-OPERATIONAL 
Green ON EtherCAT state: OPERATIONAL 
Red ON Fatal error 
Red Flickering EtherCAT state: INITIALISATION or BOOTSTRAP 

 
The behavior of ERR LED 

It LED indicate the network status or network error 

Color and behavior Meaning 

OFF No detected fault 
Red ON Fatal error 
Red blinking Invalid configuration 
Red single flashing Local error (such as synchronization error) 
Red double flashing Watchdog timeout 
Red Flickering Booting Error 

 
LED Behavior Detail 
 

 

ERR 

 

L/A X2 

RUN

X1 L/A

IN OUT 
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3. Parameters 
 

3.1. Communication parameters  

Set up the drive parameters as follows. It is necessary to reset the drive to update the parameter. 
This option doesn't operate if these parameters are not correctly set. 
 

Title Communi
cation No. 

Function Description Setting

cmod 0003 Command mode selection 

0: Terminal board 
1: Panel keypad (including remote keypad) 
2: RS485 communication 
3: CANopen communication 
4: Communcation option 

4 

fmod 0004 
Frequency setting mode 
selection 1 

0: Setting dial 1 (save even if power is off) 
1: Terminal board VIA 
2: Terminal board VIB 
3: Setting dial 2 (press in center to save) 
4: RS485 communication 
5: UP/DOWN from external logic input 
6: CANopen communication 
7: Communication option 
8: Terminal board VIC 
9, 10: - 
11: Pulse train input 

7 

f856 0856 
Number of motor pole for 
communication 

1: 2 poles 
2: 4 poles 
3: 6 poles 
4: 8 poles 
5: 10 poles 
6: 12 poles 
7: 14 poles 
8: 16 poles 

- 

f899 0899 
Communication function 
reset 

0: - 
1: Reset (after execution: 0) 

- 

 
 

3.2. Communication parameters for IPE003Z 

Title Communi
cation No. 

Function Description Default

c001 C001 Scanner input 1 address 

0: None 
1: fa06 (Communication command 1) 
2: fa23 (Communication command 2) 
3: fa07 (Frequency command, 0.01Hz) 
5: fa50 (Terminal output data from comm.) 
6: fa51 (Analog output (FM) data from comm.) 
8: f601 (Stall prevention level, %) 

13: acc (Acceleration time 1, 0.1s)*1 
14: dec (Deceleration time 1, 0.1s) *1 
15: ul (Upper limit, 0.01Hz) 
16: vb (Torque boost value 1, 0.1%) 
17: vlv (Base frequency voltage 1, 0.1V) 

100: CMD 
101: LFRD 

100*2*3

c002 C002 Scanner input 2 address 0-101 (Same as c001) 101*2*3

c003 C003 Scanner input 3 address 0-101 (Same as c001) - 
c004 C004 Scanner input 4 address 0-101 (Same as c001) - 
c005 C005 Scanner input 5 address 0-101 (Same as c001) - 
c006 C006 Scanner input 6 address 0-101 (Same as c001) - 
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Title Communi
cation No. 

Function Description Default

c021 C021 Scanner output 1 address 

0: None 
1: fd01 (Inverter status 1) 
2: fd00 (Output frequency, 0.01Hz) 
3: fd03 (Output current, 0.01%) 
4: fd05 (Output voltage, 0.01%) 
5: fc91 (Inverter alarm) 
6: fd22 (PID feedback value, 0.01Hz) 
7: fd06 (Input terminal status) 
8: fd07 (Output terminal status) 
9: fe36 (VIB input, 0.01%) 

10: fe35 (VIA input, 0.01%) 
11: fe37 (VIC input, 0.01%) 
12: fd04 (Input voltage (DC detection), 0.01%) 
13: fd16 (Estimated speed  

(real-time value), 0.01Hz) 
14: fd18 (Torque, 0.01%) 
19: f880 (Free notes) 
20: fd29 (Input power, 0.01kW) 
21: fd30 (Output power, 0.01kW) 
22: fe14 (Cumulative operation time,  

0.01 = 1 hour) 
23: fe40 (FM terminal output monitor, 0.01%) 
25: fd20 (Torque current, 0.01%) 
26: fd23 (Motor overload factor, 0.01%) 
27: fd24 (Drive overload factor, 0.01%) 
28: fd25 (PBR overload factor, %) 
29: fd26 (Motor load factor, %) 
30: fd27 (Drive load factor, %) 
31: fe56 (Pulse train input, pps) 
32: fe70 (Drive rated current, 0.1A) 
33: fe76 (Input Watt-hour, 1kWh  10f749) 
34: fe77 (Output Watt-hour, 1kWh  10f749) 
35: fd83 (IGBT temperature, degree C) 

100: ETA 
101: RFRD 

100*2*3

c022 C022 Scanner output 2 address 0-101 (Same as c021) 101*2*3

c023 C023 Scanner output 3 address 0-101 (Same as c021) -*2*3 
c024 C024 Scanner output 4 address 0-101 (Same as c021) -*2*3 
c025 C025 Scanner output 5 address 0-101 (Same as c021) -*2*3 
c026 C026 Scanner output 6 address 0-101 (Same as c021) -*2*3 
c041 C041 Scanner input 1 value The argument value set to c001 is displayed. -*3 
c042 C042 Scanner input 2 value The argument value set to c002 is displayed. -*3 
c043 C043 Scanner input 3 value The argument value set to c003 is displayed. -*3 
c044 C044 Scanner input 4 value The argument value set to c004 is displayed. -*3 
c045 C045 Scanner input 5 value The argument value set to c005 is displayed. -*3 
c046 C046 Scanner input 6 value The argument value set to c006 is displayed. -*3 
c061 C061 Scanner output 1 value The argument value set to c021 is displayed. -*3 
c062 C062 Scanner output 2 value The argument value set to c022 is displayed. -*3 
c063 C063 Scanner output 3 value The argument value set to c023 is displayed. -*3 
c064 C064 Scanner output 4 value The argument value set to c024 is displayed. -*3 
c065 C065 Scanner output 5 value The argument value set to c025 is displayed. -*3 
c066 C066 Scanner output 6 value The argument value set to c026 is displayed. -*3 

c100 C100 
Communication error 
detection delay time 

0.0 - 100.0 sec. 0.1< 

c101 C101 
Inverter operation at the 
communication loss action 

0: Stop and controlled by cmod, fmod 
1: Operation continue 
2: Deceleration stop 
3: Coast stop 
4: Network error stop (err8 trip) 
5: Preset speed operation (by c102 setting) 

- 

c102 C102 
Preset speed  
operation selection 

0: None 
1 to 15: Preset speed 

- 
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Title Communi
cation No. 

Function Description Default

c103 C103 
Communication time-out 
condition selection 

0: Disconnection detection 
1: When communication mode enable (Both 
cmod and fmod are set CANopen or 
communication option) only 

2: 1 + Driving operation 

0 

c400 C400 EtherCAT slave status 

1: INIT Initialization 
2: PREOP Pre-operational 
3: BOOTTRAP Bootstrap 
4: SAFE-OP Safe operational 

In SAFE-OP mode, inputs are updated in PDOs, 
outputs are not valid. 

8: OP Operational 
In OP mode, inputs and outputs are valid. 

-*3 

c401 C401 EtherCAT second address
0 - 65535 
Address changeable from drive or from master via 
2nd address dialog. 

0 

c402 C402 
EtherCAT address  
Actual value 

0 - 65535 
The monitor of the EtherCAT address actual value 

-*3 

c410 C410 PDO: Command1 
0x1600 subidx 0x01 Command Index No. 
0x6040: Controlword 

0x6040

c411 C411 PDO: Command2 
0x1600 subidx 0x02 Command Index No. 
0x6042: vl target velocity 

0x6042

c412 C412 PDO: Command3 0x1600 subidx 0x03 Command Index No. 0 

c413 C413 PDO: Command4 0x1600 subidx 0x04 Command Index No. 0 
c414 C414 PDO: Command5 0x1600 subidx 0x05 Command Index No. 0 
c415 C415 PDO: Command6 0x1600 subidx 0x06 Command Index No. 0 

c416 C416 PDO: Monitor1 
0x1A00 subidx 0x01 Monitor Index No. 
0x6041: vl Statusword 

0x6041

c417 C417 PDO: Monitor2 
0x1A00 subidx 0x02 Monitor Index No. 
0x6044: vl velocity actual value 

0x6044

c418 C418 PDO: Monitor3 0x1A00 subidx 0x03 Monitor Index No. 0 
c419 C419 PDO: Monitor4 0x1A00 subidx 0x04 Monitor Index No. 0 
c420 C420 PDO: Monitor5 0x1A00 subidx 0x05 Monitor Index No. 0 
c421 C421 PDO: Monitor6 0x1A00 subidx 0x06 Monitor Index No. 0 

*1: The unit depends on the f519 setting. 

*2: These parameters are according to c410 ~ c421 parameters. 

*3: These parameters are “Monitor data.” 

Note: These default values were set when the EtherCAT option was installed. 

 

 

 Warning 
 

 
Mandatory 

action 

 Set up “Communication error trip function (c100 to c103)” to stop the drive when 
EtherCAT® communication is deactivated. 
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3.3. The details of the parameter setting 

3.3.1. Network error detection (c100 - c103) 

▼Display of trip information 

err8 (Optional unit fault 1: 0x001B): Network error stop 

 
▼Related parameter 

Title Function Setting range Description 

c100 
Communication error 
detection delay time 

0.0-100.0 sec 

The waiting time from when a network error occurs 
can be adjusted. If a network error continues past 
the time set in c100, it is recognized as a 
communication error and the operation of the drive 
follows the setting of c101. 
When normal communication returns during the 

setting time, a communication error is not displayed 
and operation is continued. 
 
*The time unit time-out operates =  

EtherCAT watchdog + c100 (communication 
error detection delay time) [0.1s] 

 

c101 
Inverter operation at the 
communications loss action 

0-5 
The operation of the drive when the communication 
fault occurs can be specified. 

c102 
Preset speed operation 
selection 

0-15 
The operation frequency of the drive when the 
communication fault occurs can be specified. (Only 
when c101 is set to 5) 

c103 
Communication time-out 
condition selection 

0-2 Select the communication time-out condition. 

*The behavior of the drive in the system that connected two (or more) drive by the 

EtherCAT network. 

 

When the cable of OUT of drive at the first position is removed,  

the drive at the first position did not detect communication abnormality. 

The drive at the second position detected communication abnormality. 

The master station was able to send data (LFRD) to drive at the fist position. 

However, information (ETA and RFRD) on the drive was not able to be read. 

 

It seems that TwinCAT’s problem. 
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4. Communication Object 

Object Dictionary has mainly 3 profile sets. 

 Communication Profile Area (Index 0x1000 to 0x1FFF) 

 MB1/S15 Specific Profile Area (index 0x2000 to 0x5FFF) 

 Standard Device Profile Area (Index 0x6000 to 0x9FFF) 

 

4.1. Communication Profile 

These objects are CANopen communication configuration settings. These communication 

profile object can not be mapped into PDO. 

 

Index 
Sub 

index 
Access Type Default value Description 

0x1000 0x00 RO u32 0x00410192

Device type 
Bits 24-31 not used (0),  
Bits 16-23 = Type of device (1)  
Bits 0-15 = Device profile number (402) 

0x1001 0x00 RO u8 0x00 Error register : Error (= 1) or no error (= 0) 

0x00 RO u8 0x00 
Number of errors: Only one possible error (1), located in 
object #1003 sub 01 

0x1003* 0x01 
to 

0x10 
RO u32 (Null) 

Standard error field: 
Bits 16-31 = Additional information (always 0) 
Bits 00-15 = Error code parameter 

0x1008 0x00 RO string - 
Manufacturer device name 
This value depends on the drive name. 

0x00 RO u8 0x04 ID object: Number of objects 

0x01 RO u32 0x00000284
ID object: Supplier ID   
0x00000284 : Toshiba Schneider Inverter Co. 

0x02 RO u32 0x000000E1 Product code 
0x03 RO u32 0x00010002 Revision number 

0x1018 

0x04 RO u32 - Serial number 

*Note: Error code data are cleared of the 0x1003 object when executed the reset from 

power reset, terminal board, Panel Keypad, FA00 (reset command) and 

parameter reset (f899 = 1). 

Moreover, executed from the communication reset (CiA402 and FA06) when you 

want to hold the error code. 
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4.2. RPDO: Receive PDO 

 

Index 
Sub 

index 
Access Type Default value Description 

0x00 R/W u8 0x02 
Receive PDO mapping – Number of mapped object: 0 to 4 
objects can be mapped for this PDO 

0x01 R/W u32 0x60400010
Receive PDO mapping – 1st mapped object: Control word 
“CMD” (0x6040) 

0x02 R/W u32 0x60420010
Receive PDO mapping – 2nd mapped object: Velocity 
reference “LFRD” (0x6042) 

0x03 R/W u32 0x00000000 Receive PDO mapping: 3rd mapped object 
0x04 R/W u32 0x00000000 Receive PDO mapping: 4th mapped object 
0x05 R/W u32 0x00000000 Receive PDO mapping: 5th mapped object 

0x1600 

0x06 R/W u32 0x00000000 Receive PDO mapping: 6th mapped object 

 

4.3. TPDO: Transmit PDO 

 

Index 
Sub 

index 
Access Type Default value Description 

0x00 R/W u8 0x02 Transmit PDO mapping: Number of mapped objects. 

0x01 R/W u32 0x60410010
Transmit PDO mapping – 1st mapped object: Status word 
“ETA” (0x6041) 

0x02 R/W u32 0x60440010
Transmit PDO mapping – 2nd mapped object: Velocity 
reference “RFRD” (0x6044/00) default value 

0x03 R/W u32 0x00000000 Transmit PDO mapping: 3rd mapped object 
0x04 R/W u32 0x00000000 Transmit PDO mapping: 4th mapped object 
0x05 R/W u32 0x00000000 Transmit PDO mapping: 5th mapped object 

0x1A00 

0x06 R/W u32 0x00000000 Transmit PDO mapping: 6th mapped object 

 

 

4.4. MB1/S15 specific profile 

Drive parameters are defined as Manufacturer Specific Objects. 

Drive parameter F*** are defined as 0x2****. So drive parameters from F000 to FFFF are 

accessed from network as Objects. 

The MB1/S15 parameters are based on CANopen addresses. 

 
Parameter 

No. 
Comm. No. Object No. 

Trans.
type 

Note 

F000 ~ F999 0000 ~ 0999 
0x2000 ~ 
0x2999 

SDO 
PDO* 

User parameter area 

FA00 ~ FF99 FA00 ~ FF99 
0x2A00 ~ 
0x2F99 

SDO 
PDO* 

Disclosed command and monitor 
parameter No. can be mapped. 
Refer to the communication manual. 

A000 ~ AF99 A000 ~ AF99 
0x3000 ~ 
0x3F99 

SDO User parameter area 

C000 ~ CF99 C000 ~ CF99 
0x4000 ~ 
0x4F99 

SDO User parameter area 

*C001-C006 and C021-C026 supported parameters are able to mapping to PDO. 
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4.5. Application Profile (CiA402) 

These are contains standardized parameters in conformance with CiA402 velocity mode. 

 

Index 
Sub 

index 
Access Type 

PDO 
Mapping 

Default 
value 

Description 

0x603F 0x00 RO u16 No 0x0000 Error code 
0x6040 0x00 R/W u16 Yes 0x0000 Control Word 
0x6041 0x00 RO u16 Yes 0x0000 Status word 
0x6042 0x00 R/W i16 Yes 0x0000 Vl_Target_Velocity (min-1) 
0x6043 0x00 RO i16 No 0x0000 Vl_Velocity_Demand (min-1) 
0x6044 0x00 RO i16 Yes 0x0000 Vl_Velocity_Actual_Value (min-1) 

0x00 RO u8 No 0x02 Vl Velocity Min Max Amount 

0x01 R/W u32 No 
0x0000 
0000 

Vl_Velocity_Min_Amount (min-1) 
0x6046 

0x02 R/W u32 No 
0x0000 
05DC 

Vl_Velocity_Max_Amount (min-1) 

0x00 RO u8 No 0x02 Vl Velocity Acceleration: Highest sub-index supported 

0x01 R/W u32 No 
0x0000 
05DC 

Vl_Velocity_Acceleration Delta_Speed (min-1) 0x6048 

0X02 R/W u16 No 0x000A Vl_Velocity_Acceleration Delta_Time (s) 
0X00 RO u8 No 0x02 Vl Velocity Deceleration: Highest sub-index supported 

0x01 R/W u32 No 
0x0000 
05DC 

Vl_Velocity_Deceleration Delta_Speed (min-1) 0x6049 

0x02 R/W u16 No 0x000A Vl_Velocity_Deceleration Delta_Time (s) 
0x00 RO u8 No 0x02 Vl Velocity Quick Stop: Highest sub-index supported 

0x01 R/W u32 No 
0x0000 
05DC 

Vl_Velocity_Quick_Stop Delta_Speed (min-1) 0x604A 

0x02 R/W u16 No 0x0006 Vl_Velocity_Quick_Stop Delta_Time (s) 
0x605A 0x00 R/W i16 No 0x0002 Quick Stop Option Code 

0x6502 0x00 RO u32 No 
0x0000 
0002 

Supported drive mode 

0x6060 0x00 R/W i8 No 0x02 Mode of operation 
0x6061 0x00 RO i8 No 0x02 Mode of operation display 
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4.6. Abort code (CiA 301) 

The abort code in the below table are set in the error response data. 

 
Abort Code Contents 
0503 0000 Toggle bit not alternated. 
0504 0000 SDO protocol timed out. 
0504 0001 Client/server command specifier not valid or unknown. 
0504 0002 Invalid block size (block mode only). 
0504 0003 Invalid sequence number (block mode only). 
0504 0004 CRC error (block mode only). 
0504 0005 Out of memory. 
0601 0000 Unsupported access to an object. 
0601 0001 Attempt to read a write only object. 
0601 0002 Attempt to write a read only object. 
0602 0000 Object does not exist in the object dictionary. 
0604 0041 Object cannot be mapped to the PDO. 
0604 0042 The number and length of the objects to be mapped would exceed PDO length. 
0604 0043 General parameter incompatibility reason. 
0604 0047 General internal incompatibility in the device. 
0606 0000 Access failed due to an hardware error. 
0607 0010 Data type does not match, length of service parameter does not match 
0607 0012 Data type does not match, length of service parameter too high 
0607 0013 Data type does not match, length of service parameter too low 
0609 0011 Sub-index does not exist. 
0609 0030 Invalid value for parameter (download only). 
0609 0031 Value of parameter written too high (download only). 
0609 0032 Value of parameter written too low (download only). 
0609 0036 Maximum value is less than minimum value. 
060A 0023 Resource not available: SDO connection 
0800 0000 General error 
0800 0020 Data cannot be transferred or stored to the application. 
0800 0021 Data cannot be transferred or stored to the application because of local control. 

0800 0022 
Data cannot be transferred or stored to the application because of the present  
device state. 

0800 0023 
Object dictionary dynamic generation fails or no object dictionary is present (e.g. 
object dictionary is generated from file and generation fails because of an file error). 

0800 0024 No data available 

 

 



 E6581818 

- 17 - 

5. Drive profile 

IPE003Z has two drive profile modes, CiA 402 Drive profile mode and TOSHIBA drive 

profile mode. 

 

5.1. CiA 402 Drive profile 

Using CiA 402 Drive profile, form EtherCAT network, the drive can be controlled. 

When using the drive profile command, please set the command mode selection to 

communication option (cmod=4), Frequency setting mode selection 1 to 

communication option (fmod=7) and Number of motor poles for communication 

(f856) parameters. 

And set the RPDO mappings (0x6040) and (0x6042). 

 

*Do not select the following parameters about RPDO mappings when  

using CiA 402 Drive profile. 

- FA06, FA07,FA23 

 

5.2. TOSHIBA Drive profile 

Using TOSHIBA Drive profile, form EtherCAT network, the drive can be controlled. 

TOSHIBA Drive profile is operated when conditions are not right in CiA 402 Drive profile. 
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5.2.1.1. fa06 (Communication command1) 
 

bit Function 0 1 Note 

0 
Preset speed 
operation frequencies 
1 

1 
Preset speed 
operation frequencies 
2 

2 
Preset speed 
operation frequencies 
3 

3 
Preset speed 
operation frequencies 
4 

Preset speed operation is disabled 
or preset speed operation 
frequencies (1-15) are set by 
specifying bits for preset speed 
operation frequencies 1-4. 
(0000: Preset speed operation OFF, 
001-1111: Setting of preset speed 
operation frequencies (1-15) 

 

4 
Motor selection (1 or 2) 
(THR 2 selection) 

Motor 1 
(THR 1) 

Motor 2 
(THR 2) 

THR 1: pt = setting value, thr
THR 2: pt = 0, f170, 

f171, f172, f173
5 PI D control Normal operation PI D off - 

6 

Acceleration/decele- 
ration pattern selection 
(1 or 2) 
(AD2 selection) 

Acceleration/decel
eration pattern 1

(AD1) 

Acceleration/dec
eleration pattern 

2 
(AD2) 

AD1: acc, dec 
AD2: f500, f501 

7 DC braking OFF 
Forced DC 

braking 
- 

8 Jog run OFF Jog run - 

9 
Forward/reverse run 
selection 

Forward run Reverse run - 

10 Run/stop Stop Run - 
11 Coast stop command Standby Cost stop - 
12 Emergency stop OFF Emergency stop Always enable, "E" trip 
13 Fault reset OFF Reset No data is returned from the drive

14 
Frequency priority 
selection 

OFF Enabled 
Enabled regardless of the setting 
of fmod 

15 
Command priority 
selection 

OFF Enabled 
Enabled regardless of the setting 
of cmod 

* VF-S15:When 14(sr0) is set to fmod, preset speed operation frequency 0 is selected. 
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5.2.1.2. fa23 (Communication command 2) 
 

bit Function 0 1 Note 

0 (Reserved) - - - 

1 
Electric power quantity 
reset 

OFF Reset 
Electric power quantity (fe76, 
fe77) reset 

2 (Reserved) - - - 
3 (Reserved) - - - 
4 (Reserved) - - - 
5 (Reserved) - - - 
6 (Reserved) - - - 

7 
Maximum deceleration 
forced stop 

Normal Enabled - 

8 
Acceleration/decele- 
ration selection 1 

9 
Acceleration/decele- 
ration selection 2 

00: Acceleration/deceleration 1 
01: Acceleration/deceleration 2 
10: Acceleration/deceleration 3 

Select acceleration/deceleration 
1-4 by combination of two bits.. 
AD1: acc, dec 
AD2: f500, f501 
AD3: f510, f511 

10 (Reserved) - - - 
11 (Reserved) - - - 

12 OC stall level switch OC stall 1 OC stall 2 
OC stall 1: f601 
OC stall 2: f185 

13 (Reserved) - - - 
14 (Reserved) - - - 
15 (Reserved) - - - 

Note: Set 0 to reserved bit.    
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5.2.1.3. fa07 (frequency reference from internal option) 
 
Frequency reference is set up by 0.01Hz unit and the hexadecimal number. 
For example, when "Frequency reference" is set up to 80Hz, since the minimum unit is 0.01Hz, 

80 / 0.01 = 8000 = 0x1F40 (Hex.) 
 

5.2.1.4. fa50 (Terminal output data from communication) 
 
By setting up the data of the bit 0 - 1 of terminal output data (fa50) from communication, setting data 
(OFF or ON) can be outputted to the output terminal. 
Please select the functional number 92 - 95 as the selection (f130 - f138) of the output terminal 
function before using it. 
 

bit Output TB function name 0 1 

0 
 Specified data output 1 
(Output terminal No.: 92, 93) 

OFF ON 

1 
 Specified data output 2 
(Output terminal No.: 94, 95） 

OFF ON 

2-15 (Reserved) - - 

Note: Set 0 to reserved bit 
 

5.2.1.5. fa51 (Analog output (FM) data from communication) 
 
Use this function, set the FM terminal meter selection parameter (fmsl) to 18 (communication data 
output). 
This makes it possible to send out the data specified as FM analog output data (fa51) though the FM 
analog output terminal. Data can be adjusted in a range of 0 to 1000 (resolution of 10 bit). 
 

Please refer to "Meter setting and adjustment" Section of the VF-MB1/S15 instruction manual for details. 
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5.2.1.6. fd01 (Inverter operating status 1 (real time)) 
 

bit Function 0 1 Note 

0 Failure FL No output 
Under in 
progress 

- 

1 Failure Not tripped Tripped 
Trip status includes rtry and 
the trip retention status are also 
regarded as tripped statuses. 

2 Alarm No alarm Alarm issued - 
3 Under voltage (moff) Normal Under voltage - 

4 
Motor selection (1 or 2) 
(THR 2 selection) 

Motor 1 (THR1) Motor 2 (THR2)

THR1: pt = setting value, vl, 
vlv, vb, thr 
THR2: pt = 0, f170, f171, 
f172, f173 

5 PID control off 
PID control  
permitted 

PID control  
prohibits 

- 

6 
Acceleration/deceleratio
n pattern selection (1 or 
2) 

Acceleration/dec
eleration pattern 

1 (AD1) 

Acceleration/dec
eleration pattern 

2 (AD2) 

AD1: acc, dec 
AD2: f500, f501 

7 DC braking OFF 
Forced DC 

braking 
- 

8 Jog run OFF Jog run - 
9 Forward / reverse run Forward run Reverse run - 
10 Run/stop Stop Run - 
11 Coast stop (ST = OFF) ST=ON ST=OFF - 

12 Emergency stop 
No emergency  

stop status 
Emergency  
stop status 

- 

13 Standby ST=ON Start-up process Standby 

Standby: Initialization 
completed, not failure stop 
status, not alarm stop status 
(moff, ll forced stop), 
ST=ON, and RUN=ON 

14 Standby Start-up process Standby 

Standby: Initialization completed, 
not failure stop status and not 
alarm stop status (moff, ll 
forced stop) 

15 (Undefined) - - - 
Note: The bit described "Undefined" is unstable. Don't use the bit for the judgment. 

 

5.2.1.7. fd00 (Output frequency (real time)) 
 
The current output frequency is read into 0.01Hz of units and by the hexadecimal number.  
For example, when the output frequency is 80Hz, 0x1F40 (hexadecimal number) are read. 
 
Since the minimum unit is 0.01%, 

0x1F40 (Hex.)  = 8000(Dec.) * 0.01 = 80 (Hz) 
 
Also about the following parameters, these are the same as this. 

- fd22 (Feedback value of PID (real time)) ............................. Unit: 0.01Hz 
- fd16 (Estimated speed (real time))....................................... Unit: 0.01Hz 
- fd29 (Input power (real time)) ...............................................Unit: 0.01kW 
- fd30 (Output power (real time)) ............................................Unit: 0.01kW 
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5.2.1.8. fd03 (Output current (real time)) 
 
The output current is read into 0.01% of units and by the hexadecimal number.  
For example, when the output current of the rated current 4.8A drive is 50% (2.4A), 0x1388 (hexadecimal 
number) is read out. 
 
Since the minimum unit is 0.01%, 

0x1388 (Hex.) = 5000 (Dec.) * 0.01 = 50 (%) 
Also about the following parameters, these are the same as this. 

- fd05 (Output voltage (real time)) ............................................. Unit: 0.01% (V) 
- fd04 (Voltage at DC bus (real time)) ....................................... Unit: 0.01% (V) 
- fd18 (Torque) .......................................................................... Unit: 0.01% (Nm)* 

 
* When the motor information connected to the drive set to the parameter (f405 - f415), torque 

monitor value "100%" is same as the rated torque of a motor in general. 
 

5.2.1.9. fe35, fe36, fe37 (Monitoring of the analog input VIA, VIB, VIC) 
 
VIA terminal board monitor: "Communication Number fe35" 
VIB terminal board monitor: "Communication Number fe36" 
VIC terminal board monitor: "Communication Number fe37" 
 
These monitors can also be used as A/D converters irrespective of the drive's control. 
 
VIA / VIC terminal board monitor is capable of reading the data from external devices in a range of 0.01 
to 100.00% (unsigned data: 0x0000 to 0x2710). 
 
VIB terminal board monitor is capable of reading the data from external devices in a range of -100.00 to 
100.00% (signed data: 0xD8F0 to 0x2710). 
 
If analog input mode is selected with the frequency setting mode selection parameter, however, keep in 
mid that any data entered via an analog terminal is regarded as a frequency command. 
 

5.2.1.10. fe14 (Cumulative run time) 
 
The operated cumulative time is read by the hexadecimal number.  
For example, when cumulative operation time is 18 hours, 0x12 (18 hours) is read. 

0x12 (Hex.) = 18 (Dec., hour) 
 

5.2.1.11. fe40 (Analog output (FM)) 
 
The output value of FM terminal is read. 
The value range is set to 0 to 10000 (0x2710). 
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5.2.1.12. fc91 (Alarm code) 
 

bit Function 0 1 
Remarks 

(Code displayed on 
the panel) 

0 Over-current alarm Normal Alarming c flicking 
1 Inverter over load alarm Normal Alarming l flicking 
2 Motor over load alarm Normal Alarming l flicking 
3 Over heat alarm Normal Alarming h flicking 
4 Over voltage alarm Normal Alarming p flicking 
5 Main circuit undervoltage alarm Normal Alarming - 
6 main device overheat alarm Normal Alarming l flicking 
7 Under current alarm Normal Alarming - 
8 Over-torque alarm Normal Alarming - 
9 Braking resistor overload alarm Normal Alarming - 
10 Cumulative operation hours alarm Normal Alarming - 
11 Option communication alarm Normal Alarming - 
12 Serial communication alarm Normal Alarming - 
13 MOFFMS (MSrelay off or MOFF) Normal Alarming - 

14 Stop after instantaneous power off - 
Dec., Under 

stop 
Refer to f302 

value 

15 Stop after LL continuance time - 
Dec., Under 

stop 
Refer to f256 

value 
 

5.2.1.13. fd06 (Input TB Status) 
 

bit TB Name Function (Parameter) 0 1 
0 F Input terminal function selection 1 (f111) 
1 R Input terminal function selection 2 (f112) 
2 RES Input terminal function selection 3 (f113) 
3 S1 Input terminal function selection 4 (f114) 
4 S2 Input terminal function selection 5 (f115) 
5 S3 Input terminal function selection 6 (f116) 
6 VIB*1 Input terminal function selection 7 (f117) 
7 VIA*1 Input terminal function selection 8 (f118) 

OFF ON 

5 to 15 (Undefined) - - - 
Note: The bit described "Undefined" is unstable. Do not use the bit for the judgment. 
*1: VIA/ VIB are input terminal function when f109 is logic input. 
*The input terminal function is selected by each parameter. 
 

  
5.2.1.14. fd07 (Output TB Status) 

 
bit TB Name Function (Parameter) 0 1 
0 RY-RC Output terminal function selection 1A (f130) OFF ON 
1 OUT Output TB Function select  2A (f131) OFF ON 
2 FL Output TB Function select  3 (f132) OFF ON 

3 - 15 (Undefined) - - - 
Note: The bit described "Undefined" is unstable. Do not use the bit for the judgment. 
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6. CiA®402 – IEC61800-7 Functional Profile 

Functional description: 

Drive operation involves two main functions, which are illustrated in the diagrams below: 

 

6.1. Velocity mode object 

 

6.1.1. CiA 402 profile 

The main parameters are shown with their CiA402 name and their CiA402/Drivecom 

index (the values in brackets are the CANopen addresses of the parameter). 

 

Control diagram: 

 

 

 

 

 

Simplified diagram of speed control in “Velocity” mode: 

 

 

 

 

 

 

 

 

 

 

 

 

 
Velocity  

limit  
function 

 
 

Ramp 
function

 
 

Velocity  
Control  
function 

vl_target_velocity  
(0x6042) 

vl_target_min/max 
_amount (0x6046) 

vl_target_acceleration 
(0x6048)
vl_target_deceleration (0x6049)

vl_demand_ 
value 

vl_velocity_actual
_ 

Statusword (0x6041) bit11 (internal limit active) 

 
State- 

machineControlword  
(0x6040) 

Statusword 
(0x6041) 
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6.1.2. TOSHIBA drive profile 

These diagrams translate as follows for the MB1/S15 system: 

 

Control diagram: 

 

 

 

 

 

Simplified diagram of speed control in “Velocity” mode: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Velocity  
limit  

function 
 
 

Ramp 
function

 
 

Velocity  
Control  
function 

Frequency reference
(0x2A07) 

Lower limit frequency  
(ll: 0x2013) 
Upper limit frequency  
(ul: 0x2012) 

Acceleration time 1 (acc: 0x2009)

Deceleration time 1 (dec: 0x2010)

Output frequency 
(0x2D00) 

Estimated speed 
(0x2D16) 

Inverter operating status 1 (0x2D01) 

 
State- 

machineCommunication command 1 
(0x2A06) 

Inverter operating status 1 
(0x2D01) 
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6.1.3. Object 0x6040: Controlword 

 
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

  ms   r oms h fr  oms  eo qs ev so

MSB               LSB

ms = manufacturer-specific  

(bit11: 0 = Forward direction asked, 1 = Reverse direction asked); 

r = reserved; 

oms = operation mode specific; 

h = halt; 

fr = fault reset; 

eo = enable operation; 

qs = quick stop; 

ev = enable voltage; 

so = switch on 

 

6.1.4. Object 6041: Statusword 

 
15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

ms oms ila tr rm ms w sod qs ve f oe so rtso

MSB               LSB

ms = manufacturer-specific; 

oms = operation mode specific; 

ila = internal limit active; 

rm = remote; 

w = warning; 

sod = switch on disabled; 

qs = quick stop; 

ve = voltage enabled; 

f = fault; 

oe = operation enabled; 

so = switched on; 

rtso = ready to switch on 

 

bit 6 bit 5 bit 4 bit 3 bit 2 bit 1 bit 0 Status 

Switch on 

disabled 

Quick 

stop 

Voltage 

enabled

Fault Operation 

enabled 

Switched 

on 

Ready to 

switch on 

Status 

Word 

1 - Not ready 

to switch on 

0   0 0 0 0 - 

2 - Switch on 

disabled 

1   0 0 0 0 0x0040 

3 - Ready to 

switch on 

0 1  0 0 0 1 0x0021 

4 - Switched 

on 

0 1 1 0 0 1 1 0x0033 

5 - Operation 

enabled 

0 1 1 0 1 1 1 0x0037 
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bit 6 bit 5 bit 4 bit 3 bit 2 bit 1 bit 0 Status 

Switch on 

disabled 

Quick 

stop 

Voltage 

enabled

Fault Operation 

enabled 

Switched 

on 

Ready to 

switch on 

Status 

Word 

6 - Quick  

stop active 

0 0 1 0 1 1 1 0x0017 

7 - Fault  

reaction active 

0   1 1 1 1 - 

8 - Fault 0   1 0 0 0 *0x0008 

or 

0x0028 

: In this state, the value of the bit can be 0 or 1. 

*Detected fault following state “6 - Quick stop active”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Command coding (CiA DS402-2 DSP BV3.0 Table 27) 
Bits of the Controlword 

fault reset 
enable 

operation
Quick 
stop 

enable 
voltage 

switch on Command 

Bit 7 Bit 3 Bit 2 Bit 1 Bit 0 

Transitions 

Shutdown x x 1 1 0 2, 6, 8 
Switch on x x 1 1 1 3 
Enable operation x 1 1 1 1 4 
Disable voltage x x x 0 x 7, 9, 10 
Quick stop x x 0 1 x 7, 10, 11 
Disable operation x 0 1 1 1 5 
Fault reset ↑ x x x x 15 

x: Value is of no significance for this command. 

Not Ready to switch on 
SW: 0xXXX0 

START 

Switch on disabled 
SW: 0xXX40 or 0xXX50 

Ready to switch on 
SW: 0xXX21 or 0xXX31 

Switch on 
SW: 0xXX33 

Fault 
SW: xxxx xxxx x0xx 1000 

Fault reaction active 
SW: xxxx xxxx x0xx 1111 

Operation enable 
SW: xxxx xxxx x01x 0111 

Quick stop active 
SW: xxxx xxxx x00x 0111 

(CW: xxxx xxxx 0xxx x110) 2 7 (CW: xxxx xxxx 0xxx x01x or 
xxxx xxxx 0xxx xx0x)

6 (CW: xxxx xxxx 0xxx x110) 

5 (CW: xxxx xxxx 0xxx 0111)

(CW: xxxx xxxx 0xxx x111) 3

(CW: xxxx xxxx 0xxx 1111) 4 

11 (CW: xxxx xxxx 0xxx x01x)  

10  
(CW: xxxx xxxx 0xxx x01x or 

xxxx xxxx 0xxx xx0x)  
or  
freewheel stop  
at the terminals  
or  
modification  
of a configuration parameter

9 
(CW: xxxx xxxx 0xxx xx0x)
or 
STOP key 
or  
freewheel stop 
at the terminals 

(CW: xxxx xxxx 0xxx x110) 8 

15  
(CW: xxxx xxxx 1xxx xxxx) 
Fault disappeared and  
faults reset 

1

14 

From any state 

0

13 
CW: Controlword (0x6040) 
SW: Statusword (0x6041) 

12 
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6.1.5. CiA402 State Chart 

Description of States 

Each state represents an internal reaction by the drive. 

This chart will change depending on whether the control word is sent “CMD” or an event 

occurs (a detected fault, for example). 

The drive state can be identified by the value of the status word “ETA.” 

 

State Drive internal reaction 

1- Not Ready to switch on Initialization stats. This is a transient state invisible to the communication 

network. 

2 - Switch on disable The drive is inactive. 

The drive is locked, no power is supplied to the motor. 

3 – Ready to switched on The drive is supplied with AC power but is stationary. 

The drive is locked, no power is supplied to the motor. 

4 - Switched on The drive is supplied with AC power but is stationary. 

The drive is locked, no power is supplied to the motor. 

The power stage of the drive is ready to operate, but voltage has not yet 

been applied to the output. 

5 - Operation enabled The drive is running. 

The drive is unlocked, power is supplied to the motor. 

The drive functions are activated and voltage is applied to the motor 

terminals. 

If the reference is zero or the “Halt” command is applied, no power is 

supplied to the motor and no torque is applied. 

“ATN” Auto tuning requires an injection of current into the motor. The drive 

must therefore be in state “5 - Operation enabled” for this command. 

NOTE: The command “4 - Enable operation” must be taken into 

consideration only if the channel is valid. In particular, if the channel is 

involved in the command and the reference, transition 4 will take place only 

after the reference has been received for the first time. 

6 - Quick stop active Emergency stop. 

The drive performs a fast stop, after which restarting will only be possible 

once the drive has changed to the “Switch on disabled” state. 

During fast stop, the drive is unlocked and power is supplied to the motor. 

The condition for transition 12 to state “2 - Switch on disabled” depends on 

the value of the parameter “Quick stop mode”: 

If the “Quick stop mode” parameter has the value 0, the drive stops freewheel 

and then changes to state “2 - Switch on disabled”. 

If the “Quick stop mode” parameter has the value 1, the drive stops according 

to the slow down ramp and then changes to state “2 - Switch on disabled”. 

If the “Quick stop mode” parameter has the value 2, the drive stops according 

to the quick stop ramp (0x604A) and the changes to state “2 - Switch on 

disabled”. 

Do not set the value 3 to “Quick stop parameter”. 

If the “Quick stop mode” parameter has the value 4, the drive stops according 

to the voltage limit and the changes to state “2 - Switch on disabled”. 
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State Drive internal reaction 

7 - Fault reaction active Transient state during which the drive performs an action appropriate to the 

type of detected fault. 

The drive function is activated or deactivated according to parameter f603 

when detected the emergency stop. 

8 - Fault Drive has detected a fault. 

The drive is locked, no power is supplied to the motor. 

 

Summary 

State Power supplied to motor 

1 - Not ready to switch on No 

2 - Switch on disabled No 

3 - Ready to switch on No 

4 - Switched on No 

5 - Operation enabled Yes 

6 - Quick stop active Yes, during fast stop 

7 - Fault reaction active Depends on parameter f603 when detected 

the emergency stop. 

8 - Fault No 
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6.1.6. Object 0x6042: vl_target_velocity 

This object shall indicate the required velocity of the system. The value is given in 

revolutions per minute (min-1). Positive values forward direction and negative values 

indicate reverse direction. 

At changing to “Operation enable” state, this target velocity is cleared. So set this target 

velocity data after changed the state to “Operation enable.” 

 
 

 Warning 
 

 
Mandatory 

action 

 This object value is depending on the f856 parameter and confirms it setting value. 
The motor rotational speed of the forecast is not obtained when the setting is mistaken, 
and there is danger of causing the accident etc. 

 

6.1.7. Object 0x6043: vl_velocity_demand 

This object provides the instantaneous velocity generated by the ramp function. It is an 

internal object of the drive device. The value is given same unit as the vl_target_velocity. 

Positive values indicate forward direction and negative values indicates direction. 

 

6.1.8. Object 0x6044: vl_velocity_actual_value 

This object provides the velocity at the motor spindle or load. Depending on the 

implementation (simple drive device, without sensor, etc.), the drive provides the 

appropriate image of the actual velocity (velocity demand, velocity control effort, 

calculated velocity). 

The value is given in the same unit as the vl_taget_velocity. A positive value indicates 

forward direction and negative values indicates reverse direction. 

 

6.1.9. Object 0x6046: vl_velocity_min_max_amount 

This object indicates the configured minimum and maximum amount of velocity (unit 

min-1). The vl_velocity_max amount sub-object is mapped internally to the 

vl_velocity_max positive and vl_velocity_max negative values. The vl_velocity_min 

positive and vl_velocity_min negative values. 

At initial configuration, the Upper limit frequency (ul) and Lower limit frequency (ll) of 

the drive may be not same value with Object 0x6046 setting value. And when changes 

the upper limit frequency and the lower limit frequency of the drive parameter, Object 

6046 value is different with the drive parameters. To correspond these limit value, set 

Object 6046. 

 



 E6581818 

- 31 - 

6.1.10. Object 0x6048: vl_velocity_acceleration 

This object indicates the configured delta speed and delta time of the slope of the 

acceleration ramp. 

Velocity Acceleration Delta Speed : 225 to 30,000 min-1 

Velocity Acceleration Delta Time : 0.1 to 3,600 s 

 

Note: Do not change the acceleration/deceleration time unit (parameter f519), if 

change the parameter, the setting value range will be different from above range. 

 

6.1.11. Object 0x6049: vl_velocity_deceleration 

This object indicates the configured delta speed and delta time of the slope of the 

deceleration ramp. 

Velocity Deceleration Delta Speed : 225 to 30,000 min-1 

Velocity Deceleration Delta Time : 0.1 to 3,600 s 

 

Note: Do not change the acceleration/deceleration time unit (parameter f519), if 

change the parameter, the setting value range will be different from above range. 

 

6.1.12. Object 0x604A: vl_velocity_quick_stop 

This object indicates the configured delta speed and delta time of the slope of the 

deceleration ramp for quick stop. 

deceleration ramp. 

Velocity Deceleration Delta Speed : 225 to 30,000 min-1 

Velocity Deceleration Delta Time : 0.1 to 3,600 s 

Note: Do not change the acceleration/deceleration time unit (parameter f519), if 

change the parameter, the setting value range will be different from above range. 

 

6.1.13. Object 0x605A: Quick stop option code 

This object shall indicate what action is performed when the quick stop function is 

executed. 

The slow down ramp is the deceleration value of the used mode of operations. 

 
Value Definition 

-32768 to -1  No function 
0 Disable drive function 

+1 Slow down on slow down ramp and transit into Switch On Disabled 
+2 Slow down on quick stop ramp and transit into Switch On Disabled 
+3 Do not set 
+4 Slow down on voltage limit and transit into Switch On Disabled 
+5* Slow down on slow down ramp and stay in Quick Stop Active 
+6* Slow down on quick stop ramp and stay in Quick Stop Active 
+7* Do not set 
+8* Slow down on voltage limit and stay in Quick Stop Active 

+9 to +32 767 Reserved 

*Not supported these values. Do not set these values. If set the value 5-8, the drive slow 

down ramp and transit into Switch On Disabled. 
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6.1.14. Object 0x6060: Mode of operation 

The object shall indicate the requested operation mode. 

This module supports the “vl (= 2)” (velocity mode) only. 

 

NOTE: This object shows only the value of the requested operation mode, the actual 

operation mode of the PDS* is reflected in the object modes of operation display. 

*PDS: Power drive system 

 
Value Definition 

-128 to -1  Manufacturer-specific operation modes 
0 No mode change/no mode assigned 

+1 Profile position mode 

+2 Velocity mode 

+3 Profile velocity mode 
+4 Torque profile mode 
+5 Reserved 
+6 Homing mode 
+7 Interpolated position mode 
+8 Cyclic sync position mode 
+9 Cyclic sync velocity mode 

+10 Cyclic sync torque mode 
+11 to +127 Reserved 

 

6.1.15. Object 0x6061: Mode of operation display 

This object shall provide the actual operation mode. 

This module supports the “vl (= 2)” (velocity mode) only. 

 

6.1.16. Object 0x6502: Supported drive mode 

This object shall provide information on the supported drive modes. 

This module supports the “vl (= 2)” (velocity mode) only. 

 
31    16 15    10 9 8 7 6 5 4 3 2 1 0 

Manufacturer-specific r(reserved) cst csv csp ip hm r tq pv vl pp

MSB                   LSB
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6.2. Object 603F: Error Code 

Below table describes the relations of the error code and drive error. 

 
Error  
code Meaning Drive trip 

code 
Drive error 

name Drive condition 

0x0000 No error 0x00 --- --- 

0x1000 Generic error 

0x0E 
0x15 
0x16 
0x17 
0x1A 
0x1C 
0x28 
0x35 
0x3A 
0x54 
0x55 
0x56 

ol2 
err2 
err3 
err4 
err7 
err9 
etn 
e-21 
e-26 
etn1 
etn2 
etn3 

Motor overload 
Main unit RAM fault 
Main unit ROM fault 
CPU fault 1 
Current detector fault 
Remote keypad disconnection fault 
Auto-tuning error 
CPU fault 2 
CPU fault 3 
Auto-tuning error 
Auto-tuning error 
Auto-tuning error 

0x2230 Short circuit/earth leakage  
(device internal) 0x05 oca Overcurrent at start-up 

0x2310 Continuous over current 
0x01 
0x02 
0x03 

oc1 
oc2 
oc3 

Overcurrent during acceleration 
Overcurrent during deceleration 
Overcurrent during constant  
speed operation 

0x2311 Continuous over-current No. 1 
0x20 
0x41 
0x48 

ot 
ot2 
 

Over-torque trip 1 
Over-torque trip 2 
Over-torque / Overcurrent fault 

0x2320 Short circuit/earth leakage  
(motor-side) 0x04 ocl 

Overcurrent (An overcurrent on the  
load side at start-up) 

0x2330 Earth leakage 0x22 ef2 Ground fault 

0x3110 Mains over-voltage 

0x0A 
0x0B 
0x0C 

 

op1 
op2 
op3 

 

Overvoltage during acceleration 
Overvoltage during deceleration 
Overvoltage during constant  
speed operation 

0x3120 Mains under-voltage 0x1E up1 Undervoltage fault (main circuit) 
0x3130 Phase failure 0x08 eph1 Ground fault 

0x3310 Output over-voltage 
0x09 
0x0F 
0x47 

epho 
olr 
 

Output phase failure  
Dynamic braking resistor overload trip
Auto-tuning error(PM motor) 

0x4210 Excess temperature device 
0x0D 
0x10 
0x3E 

ol1 
oh 
ol3 

Inverter overload 
Overheat 
Main module overload 

0x5530 Control EEPROM failure 

0x12 
0x13 
0x14 
0x29 

eep1 
eep2 
eep3 
etyp 

EEPROM fault 1 
EEPROM fault 2 
EEPROM fault 3 
Inverter type error 

0x6100 Internal software 0x33 
0x37 

e-19 
e-23 

CPU communication error 
Optional unit fault 2 

0x7300 Sensor 
0x2E 
0x32 
0x40 

oh2 
 

e-18 
e-32 

Thermal fault stop command from  
external device  
Analog input break detection fault 
PTC fault 

0x7310 Speed 0x2D e-13 Over speed fault 
0x7510 Serial interface No. 1 0x18 err5 Communication error 
0x7520 Serial interface No. 2 0x1B err8 Optional unit fault 1 

0x8331 Torque fault 0x2F 
0x34 

sout 
e-20 

Step-out (for PM motor drive only) 
Over torque boost fault 

0x8501 Servo lock failure 0x45 e-37 Servo lock fault 
0x9000 External malfunction 0x11 e Emergency stop 

0xFF00 Additional functions 
- generic error 0x54 etn1 Auto-tuning error 

0xFF03 Device specific 
- generic error 

0x1D 
0x3B 
0x49 

uc 
prf 
 

Low-current operation fault  
Safe torque off error  
Small-torque / Small -current fault 
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7. EtherCAT State Machine (ESM) 
ESM Diagram 

The EtherCAT State machine coordinates the master and slave applications at start up 

and during operation. State changes are typically initiated requests of the master. They 

are acknowledged by the local application after the associated operations have been 

executed. 

 

Description of the states management 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ESM states 

The state Init defines the foundation of the communication relationship between the 

master and the slaves at the application layer. Direct communication between the master 

and the slave is impossible at the application layer. The master uses the Init state to 

initialize a set of configuration registers of the EtherCAT slave controllers. If the slaves 

support mailbox services is configured in this state. 

 

In the Pre-Operational sate, the mailbox is active. Both master and slave use the 

mailbox and the corresponding protocol to interchange application-specific initialization 

data and parameters. In this state, process data communication is not possible. 

 

If the drive does not receive a valid mapping for the process data from the EtherCAT 

master, it remains in this state. 

 

In the Safe-Operational state, the slave application provides current input data such as 

limit switch data. 

Output data of the master are ignored in this state. This is not a safety function. 

 

In the state Operational, the slave applications deliver current input data and the drive 

processes the current output data from the drive, such as target velocity. 
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State transitions 

State transition Local management service Value 

IP Start Mailbox Communication 0x02 

PI Stop Mailbox Communication 0x01 

PS Start Input Update 0x04 

SP Stop Input Update 0x02 

SO Start Output Update 0x08 

OS Stop Output Update 0x04 

OP Stop Output Update and Stop Input Update 0x02 

SI Stop Input Update, Stop Mailbox Communication 0x01 

OI Stop Input Update, Stop Mailbox Communication 0x01 

IB Start Bootstrap Mode, redirection to (BI) 0x03 

BI Restart Device 0x01 

 

ESM states management 

The ESM states are managed with the library: TC EtherCAT lib. See the example, step 

15 page 46. 

 

ESM states and communication interruptions 

The ESM states are managed with the library: TC EtherCAT lib. See the example, step 

15 page 46. 

Some transitions in the ESM state chart will trigger a communication interruption. 

 

These transitions suppress a service, which can be used to control the drive. 

A detected fault is triggered in order to avoid losing control of the drive (only if the drive is 

running). 

 

State transition Service lost Communication network 

PI SDO 

SI SDO, TPDO 

SP TPDO 

No possible t alarm or err8 

OS RPDO 

OP PDO 

OI SDO, PDO 

If drive was enabled (Statusword = 

0xXXX7) then occurs the t alarm or 

err8. 

 

Depending on the communication status of the drive, the following services are available: 

 

 Init Pre-operational Safe-Operational Operational 

PDO   TPDO, inputs only active,  

no outputs to drive active 

X 

SDO  X X X 
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8. Example: VF-MB1 with TwinCAT® “PLC - Configuration” 
This example shows a combination of VF-MB1 with TwinCAT® option. 

When you use VF-S15, please read MB1 as S15. 

 

8.1. Hardware 

Connect your computer and the IPE003Z with a standard Cat 5e minimum cable (2 x 

RJ45, shielded twisted pair cable). 

 

8.2. TwinCAT® software installation 

Install the TwinCAT® software copyright BECKOFF. Example realized with TwinCAT® 

software version 2.11. 

Note: The screenshots or procedure in this example can change with a new TwinCAT®  

Filename: TOSVERT_Vxxx.xml 

 

There are ESI files for VF-MB1 and VF-S15. 

 

Copy this XML file on your computer in C:¥TwinCAT¥Io¥EtherCAT. 

 

8.3. ESI file (EtherCAT Slave Information) 

You can use the ESI file in XML format for VF-MB1 and VF-S15. 

 

The ESI file must be integrated into the system on the master controller. 

For example (directory pass): C:¥TwinCAT¥Io¥EtherCAT 

 
As for acquisition of an ESI file, please contact your Toshiba distributor. 

 

8.4. MB1 configuration 

Realize the configuration on the Drive for Operation With CiA402 Profile in Combined 

Mode. 

Set cmod to 4 and fmod to 7 and controlled with 0x6040 and 0x6041 objects. 
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8.5. System Manager: Declare your computer on Ethernet network 

Start TwinCAT® system-manager®  

 

Select Options -> “Show Real Time Ethernet Compatible devices” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select your Computer Ethernet board, and “Install”. 

 Enable it. 
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8.6. System Manager: Install the master 

In this example we use the computer to run TwinCAT® and PLC runtime as Mater. 

 Select “Choose Target” 

 Select “Search (Ethernet)” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Start the “Broadcast Search” 

 Select your Master in the Host Name list (your computer in this example) 
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 Check that you are in “config mode” 
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8.7. System Manager – Install the slave: MB1 in “PLC- configuration” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select the I/O Devices -> Scan Devices

 Choose the “OK.”

 Check the “Device 1[EtherCAT]” -> Choose the “OK.” 

 Choose the “Yes”.  Choose the “Yes.”

 Shows the boxes and activates Free Run.
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8.8. PLC – Control: initialization 

Start TwinCAT PLC control® software  

File -> new 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select; Resources -> Library Manager 

Add EtherCAT libraries 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add TcEtherCAT.lib All EtherCAT libraries are added: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ST: Structured language
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8.9. PLC – Control: Declare the variables 

Select Global_Variables 

 

 

 

 

 

 

 

Create the Master Global_Variables for MB1 as below. Copy/paste the variables: 

VAR_GLOBAL 

MB1_State AT %I*:WORD; 

PLC_state AT %I*:UINT; 

MB1_TPDO_Input1_Status_Word AT %I*:WORD; 

MB1_TPDO_Input2_Control_Effort AT %I*:WORD; 

MB1_TPDO_Input3 AT %I*:WORD; 

MB1_TPDO_Input4 AT %I*:WORD; 

MB1_TPDO_Input5 AT %I*:WORD; 

MB1_TPDO_Input6 AT %I*:WORD; 

MB1_RPDO_Output1_Control_Word AT %Q*:WORD; 

MB1_RPDO_Output2_Target_Velocity AT %Q*:WORD; 

MB1_RPDO_Output3 AT %Q*:WORD; 

MB1_RPDO_Output4 AT %Q*:WORD; 

MB1_RPDO_Output5 AT %Q*:WORD; 

MB1_RPDO_Output6 AT %Q*:WORD; 

END_VAR 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reminder: 

 RPDO (Receive PDO), containing 6 input words of the communication scanner  

c410 to c415. 

 TPDO (Transmit PDO), containing 6 input words of the communication scanner  

c416 to c421. 
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Add 1 instruction minimum in POUs before rebuild; 

 

 

 

 

 

 

 

 

 

 

 

Select: Project -> Rebuild All 

Check the compilation result without error. 

This action creates file in: C:¥TwinCAT¥Plc 

As example, create: TSB_MB1_sample.tpy 

 

8.10. System Manager – Append PLC Project 

In System Manager software, realize the link between the Master and the slave. Creation 

of the links between “PLC – Configuration” and “I/O - Configuration” 

 

Select “Append PLC Project…”: 

 

 

 

 

 

 

 

 

 

 

As example, select: C:¥TwinCAT¥Plc¥TSB_MB1_sample.tpy 

 

For each parameter, create the lint with the MB1/IO listing 

 

 

 

 

 

 

 

 

 

 

 

; 
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Example for “MB1_State” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Links to create 

 

PLC – Configuration I/O - Configuration 

Inputs MB1_State State 

Inputs PLC_State DevState (with Device1) 

Inputs MB1_TPDO_input1_Status_Word Status word 

Inputs MB1_TPDO_input2_Control_Effort Control effort 

Inputs MB1_TPDO_input3 Available for other parameter 

Inputs MB1_TPDO_input4 Available for other parameter 

Inputs MB1_TPDO_input5 Available for other parameter 

Inputs MB1_TPDO_input6 Available for other parameter 

Outputs MB1_RPDO_Output1_Control_Word Control word 

Outputs MB1_RPDO_Output2_Target_Velocit

y 

Target Velocity 

Outputs MB1_RPDO_Output3 Available for other parameter 

Outputs MB1_RPDO_Output4 Available for other parameter 

Outputs MB1_RPDO_Output5 Available for other parameter 

Outputs MB1_RPDO_Output6 Available for other parameter 

 

Note: if more than 6 input or output parameters are created in TwinCAT® System 

Manager, the MB1 will be blocked in “PreOp” State. The MB1 has maximum 6 

TPDO and 6 RPDO. 

 

Select: Actions -> Generate Mappings. 
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8.11. PLC - Control: new compilation 

Select: Project -> Rebuild All 

This action updates the information. 

 

8.12. System Manager: Activate configuration 

Select: Actions -> Activate Configurations 

 

8.13. PLC - Control: Run 

Select: Online -> login 

 

 

 

 

 

 
 
Select: Online -> Run 
 
The PLC and the EtherCAT fieldbus are now running. 

In TwinCAT® PLC Control, you see the list of the variables and values: 
 
 

 

 

 

 

 

 

 

 

 

 

8.14. PLC - Control: start and stop the motor 

To modify the MB1 state, refer to CiA402 state chart page 26. 

Example to start motor: 

1. The MB1 is on “switch on disabled” state. 

2. Set “TSB_MB1_RPDO_Output1_Control_Word (%QB0)” = 0x0006 

3. The MB1 is on “ready to switch on” state. 

4. Set “TSB_MB1_RPDO_Output1_Control_Word (%QB0)” = 0x0007 

5. The MB1 is on “switch on” state. 

6. Set “TSB_MB1_RPDO_Output1_Control_Word (%QB0)” = 0x000F 

7. The MB1 is on “operational Enable” state. 

8. Set “TSB_MB1_RPDO_Output2_Target_Velocity (%QB2)” = 0x05DC 

9. The Motor stats, and the MB1 displays “50.0”Hz 

10. Set “TSB_MB1_RPDO_Output1_Control_Word (%QB0)” = 0x0000 

11. The motor stops and MB1 go back on “switch on disabled” state. 



 E6581818 

- 46 - 

8.15. PLC - Control: add a library for other services 

Install the library: TcEtherCAT.lib 

 

 

 

 

 

 

 

 

 

 

 

 

Example for exchanges with SDO 
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Example for exchanges with ESM states 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.16. Method of add the PDOs 

Select the “Process Data” tag 

Select the “PDO List” (Inputs or Outputs) 

Select the “PDO content” 

Right click and select the “Insert…” 
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Set the Name of PDO 

Set the Index of PDO 

Set the Data Type of PDO

Set the Sub Index of PDO 
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